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Chapter 1. Introduction

Welcome! Your personal computer is now a powerful Bible study tool.
The Bible Companion Series for Windows combines Bibles, exhaustive
word lists, advanced concordance searches, resource tools, personal
commentary, and notepads. Al in an easy-t1o-learn, easy-to-use program
with context-sensitive help every step of the way.

Learning to Use Companion

Fhe Bible Companion Series for Windows (or, for brevity, Companion) is
i Teature-rich Bible study tool. Although it can take awhile for the
beginner to master Companian, the key to learning is to take one step at a
lime. We recommend the following steps:

. Read this “Introduction.”
2. Install Companion as described later in this chapter.

3. Work through the tutorial included on the Companion CD and read
this manual to explore the following topics:

VIEW Browsing the Bible text

WORD Companion’s exhaustive Bible word list
SEARCH Performing and manipulating searches
PEEK Viewing search verses in context
COMDNENTARY  Verse by verse comments and resources
TOPICS Independent topical entries

LEXICON Greek/Hebrew-to-English definitions
NOTEPAD Pop-up Notepads within Companion.

4. Learn (o customize Companion to your tastes by examining topics
such as “options,” “DDE,” and “chipboard.”

5. Use Help (described later in this Chapter) and this manual to find
answers to questions that arise as you use Companion. To help you
find information quickly, this manual has:

s A table of contents
s Anindex
* A glossary

* A “reference summary” that covers menus, buttons, and
keystroke commands.
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Hardware Requirements
* IBM AT, PS/2, and most compatibles
* Microsoft Windows 3.1
* Hard Disk (0.5Mb for program; 4Mb for average Bible version)
* Windows-supported CD drive
* Windows-supported graphics monitor
* Windows-supported printer (optional)

* Windows-supported mouse (recommended).

Keystroke Conventions

In Companion and this manual, keystrokes are shown within braces: for
example: “Press <Enter>.”

Companion sometimes uses “shifted” keys. This is a key that is pressed
in combination (simultaneously) with the <Shift>, <Alt>, or <Cirl>
keys. When a shifted key is referred to, the “shift” key is first and there is
no space or comma between the keys. Example: “Press <Ctrls><PgDn>.”

Software Conventions

General

Companion uses the Microsoft Windows operating environment and user
interface tools. If you are not familiar with the user interface of Windows
programs, please refer to vour Windows user manual and tutorial
materials.

Escape

When all else fails, use the <Esc>ape hatch. Generally, the <Ese> key
will get you out of most anything you’ve gotten yourself into. Note that
il you press <Ese> in a dialog box, you’ll lose any changes. Also, note
that the <Iise> key will move you backward through the hypertext jumps
and Bible scarch levels.

Instead of <IEsc>, you can also click the right mouse button in J'i
window, or you can click the Escape Ribbon Bar button. el
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Installing Companion
Companion and its Bible databases are provided on a CD. A typical
installation involves installing Companion, but not the Bible databases,
to a hard drive. (You access the Bible dutabases from the CD.)
To install Companion:
. Put the Companion CD in the CD drive.
2. Choose “Run” from Program Manager or File Manager.
3. Type: XASETUP (where ‘X’ is the drive letter of your D drive)
4. Click OK and foliow the screen instructions.

Companion installs on the hard drive you selected. The Bible databases
are not copied from the CD. The companion icon appears appears in the
Program Manager window.

Refer to the “Supplementary Installation Instructions” in Chapter 10,
“Technical Notes,” if you want to:

» Copy the Bible databases to the hard drive (which speeds up access)

Add supplementary Bible databases

[nstall Greek and Hebrew fonts

Make program updates

Reinstall the Companion icon in Program Manager.

Starting Companion

L. 11 you are using Bible databases that are on the CD and have not
been copied to the hard drive, insert the CD into the CD drive.

2. Start Companion by double-clicking the Companion icon in the
Windows Program Manager.
[t your Bible databases are on CD, wait a moment for data to be
transferred from the CD.

3. Click OK to clear copyright notices from the screen.

Companion opens with the same texts and format options that were in
effect when it was last closed.
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Getting Help

Context-Sensitive Help

You can get Help by clicking on a dialog box’s Help button, the Ribbon
Bar Help button or by pressing <FI> in a child window. The following is
an example of Hetp provided for a STUDY window (in VIEW mode):

File Edit View Search Words Oplmns Windnw Help

{ 5| R | G| 0 js* =l

K.JS King James

o

The following is a summary of comman operations n YEVy made

Go o prinr ook <Home>

50 to prior chiapter <PgUp>

Move up nne verse <Up> or <Left-
Wove dovn ane sasdandows fLl <Space»

Move down ane verse <Down> ar <Right>
5o to nest chapter <Pgbn>

5o to nest hook <End>

L — 2

This “context-sensitive” Help text displays pre-set to your current
program function. If you wish, you may move to other portions of the
Help text with the cursor keys, or browse Help and click on highlighted
words. Once you are in Windows Help, you can click the Contents
button to view a complete list of Help topics.

Help Menu

In addition to context-sensitive Help, the Help menu provides General
Help, an Index to Help topics, and a Demo Script (tutorialy,

Ribbon Bar

Companion offers a Ribbon Bar that makes most common features a
simple mouse click away. Companion can display a small yellow
window beneath the Ribbon Bar that tells you what each button does, as
you move the mouse pointer over the button.

e - F
(ks King ames e b} (S|l el |2
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The Multiple Document Interface

Companion is a Windows Multiple Document Interface (MDT) program,
MDI standards were developed especially for word processing and
spreadsheet programs to let users view and edit multiple documents at
the same time. Companion exploits and builds on this concept. Instead of
multiple documents, think of Companion as a manager of multiple Bibles
(we also call them STUDIES), notepads (NOTEPADS), Strong’s and
other lexicons (LEXTCON), up to 10 “verse by verse” COMMEN- -
TARYs, and up to 10 TOPICS windows.

Each tool gets its own “child” window within the larger Companion
window. They all share a common menu and Ribbon Bar, and can take
advantage of special synchronization features.

The following MDI features help you manage these windows:

Minimizing a Window

You can minimize a child window to an icon to temporarily hide it. In
the upper right corner of the child window are two arrow buttons. If you
click on the down arrow button, the window will be minimized to an
icon at the bottom of the Companion main window. To restore a
minimized icon window to its former size, double-click it.

Maximizing a Window

You can maximize a child window to fill the available Companion main
window by selecting the up arrow button in the upper right corner. The
screen will expand to fill the entire area.

Returning a Maximized Window to Size

Once a child window is maximized, the two huttons disappear and a
button with both up and down arrows appears on the menu line. Click
this button to reduce the window to its former size.

Tiling Windows
The Horizontal Tile and Vertical Tile ribbon buttons tile child
windows horizontally and vertically respectively.

Other Options

The Window menu offers other management options, like tiling or
cascading windows and arranging icons. And, of course, you can move
and re-size the windows to suit your fancy. Refer to your Windows
documentation for basic window management functions.
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Companion Basic Overview

Companion uses several different types of windows to assist you in your
Bible study. The following are the 5 primary window types:

« STUDY Four Bible study modes (see below)
« COMMENTARY Verse-by-verse Resources

* LEXICON Original language dictionaries

« TOPICS Independent hypertext topics

* NOTEPAD Independent sermon/lesson notes.

You can open several windows. The following screen has two STUDY
windows (KIS and optional BHS), one LEXICON window, and one
COMMENTARY window (NASB Concord.):

File Edit VYiew Search Vfords Options Wmdow Help .
L] | | ) ) BRI (2] 22
IKJS King James sz g* EI@I' El

View Gene 1:1 [KJS]
U0 the beginning God created the heaven and the earth. * And B
the earth was without form, and void; and darkness [was] upon :

the face of the deep. And the Spirit of God moved upon the face

Vlew Gepe 1;1: [BHS] . ;
} z. m: ooy m
LA A e W o) 1 SRS B A TR

'=]‘ i Treasury SK < Gene 1:1:; "}sﬁ--v".']x"l:* F-| e NASB Concord, #1 .. !
1 God creates heaven and earth; ||l 1. ab (3a); from an ululse(l wor d
3 the light; Father - ancastors(l).
6 the finnament, Family¥(1), tatherfsi -},

STUDY Windows

The STUDY window is the richest Companion window type, containing
several levels (or “modes”) that reflect the way most people study the
Bible. First, they begin browsing Bible text, then look up a word or start
a search tor a word or plirase, and then peruse the verses containing the
search target.
The STUDY window follows this process using four consecutive levels:
1. VIEW. View and scrolt verses
2. WORD List. View/search exhaustive list of Bible words
3. SEARCIH. Scarch for a word or phrase
4

. PEEK. Peck at a search verse in context.
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The WORD LIST mode is optional, since you can SEARCH directly
from VIEW. To move backward to a prior level, you can:

« Press the <Esc> key
» Click the right mouse button in the STUDY window
* Click on the Escape ribbon bar button

» Select Prior Study Mode on the Window menu.

These STUDY levels offer a simple, logical approach to Bible study.
However, as people study, many of them have search/study ideas they
would like to pursue in the midst of this logical progression. But,
eventually they would like to come back to their point of departure.
Companion’s MDI lets you suspend a current STUDY and initiate a new
STUDY or NOTEPAD for jotting down a few ideas. When you are
finished, you can close that window and return to your prior STUDY. Or,
you can even move to a new Companion Bookshelf.

COMMENTARY Windows

COMMENTARY windows are unique Companion windows because
these “verse by verse” Resources “synchronize” their content to the
active STUDY window when the Synchronize option 18 sel.
COMMENTARY offers “verse-by-verse” personal notes (User
Commentary), user cross-references (UXREF), and other Bible Resour-
ces such as the Treasury of Scripture Knowledge (TSK), Scofield Notes
(SCOFIELD), and others. Searches and hypertext jumps are available for
COMMENTARY windows.

TOPICS Windows

TOPICS windows can contain separate, topically organized material such
as Dictionaries and other topical studies.

LEXICON Windows

The L.LEXICON window contains Greek and/or Hebrew word definitions
and is generally organized via standard or custom Strong’s Numbers. a
I.EXICON window is considered to be a specialized TOPICS window.

NOTEPAD Windows

The NOTEPAD is a simple text editor for preparing lesson outlines,
notes, or sermons.
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Companion Desktops

Companion lets you maintain four different sets of window
arrangements and switch between them. These
arrangements are called “Desktops.”

When a new Desktop is chosen, the existing Desklop layout is preserved
and the new one is adopted. You can use this for keeping dilferent types

of window arrangements for different styles of Bible study. For example,
different family members can have their own Desktop without affecting

other members’ preferences.
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